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Sound File Format - Định dạng File âm thanh
Bắt đầu từ một file âm thanh, có 3 b ước để tạo thành mẫu chip voice như sau đây:

Starting from a sound source file, t here are three steps to prepare a voice chip sa mples. They are:

● Sound Editing - Chỉnh sửa/ biên tập âm thanh
● Sound Compile - Biên dịch âm thanh (tạo thành file data từ các file âm thanh gốc và các cấu hình cho chip)

● Voice Chip Programming - Nạp dữ liệu cho chip Voice

Suppose the sound comes from CD. The sound source will have format, 44100Hz sampling rate, stereo and 16Bit
per sample. We must convert the sound from CD into the following fo rmat: Các âm thanh nguồn ghi trên đĩa CD có
định dạng: tốc độ lấy mẫu 44100Hz, stereo v à 16Bit mỗi mẫu. Vì thế chúng ta phải chuyển đổi âm tha nh từ CD thành định
dạng sau:

● Sound file in WAV format - File âm thanh trong định dạng WAV
● 8 Bit per sample - 8 Bit mỗi mẫu

● MONO channel - Kênh MONO

Therefore we need the help of sound editing software to convert the sound source captured from CD into

the required format. Do vậy ta cần phần mềm biên tập âm thanh để chuyển đổi nguồn âm thanh trích từ đĩa CD
(hoặc ghi từ bất kỳ nguồn nào) thành định dạng đã yêu cầu trên.

The table below shows how to calculate the target sampling rate with different encoding to fit into different OTP
voice chip. Bảng sau chỉ ra cách tính toàn tốc độ lấy mẫu cần thiết với mã hoá khác nhau để vừa vào chip Voice khác nhau

OTP

Chip

Kích thước bộ nhớ,
mã hoá(4BIT/5BIT)

Memory Size
ADPCM / u-Law

(4BIT/5BIT)
Encoding

Kích thước bộ
nhớ mã hoá

PCM

Memory Size
PCM (8BIT)

Encoding

Calculation of Sampling Rate

( Memory Size / Sec ) for 4BIT / 8BIT

( Memory Size*0.8 / Sec ) for 5BIT

Tính toán tốc độ lấy mẫu cho mã hoá:
 (Memory Size / Sec) cho 4Bit/ 8Bit, (Memory Size*0.8 / Sec) for 5BIT

10 sec 64K 32
K

If ex 5sec voice S.R. = 64K / 5sec ≒ 12.8K HZ ( ADPCM )

If ex 5sec voice S.R. = 32K / 5sec ≒ 6.4K HZ ( PCM )

If ex 5sec voice S.R. = 64K*0.8 / 5sec ≒ 10.2K HZ ( u-Law )

21 sec 128K 64
K

If ex 8sec voice S.R. = 128K / 8sec ≒ 16K HZ ( ADPCM )

If ex 8sec voice S.R. = 64K / 8sec ≒ 8K HZ ( PCM )

If ex 8sec voice S.R. = 128K*0.8 / 8sec ≒ 12.8K HZ ( u-Law )

42 sec 256K 128
K

If ex 12.8sec voice S.R. = 256K / 12.8sec ≒ 20K HZ ( ADPCM )

If ex 12.8sec voice S.R. = 128K / 12.8sec ≒ 10K HZ ( PCM )

If ex 12.8sec voice S.R. = 256K*0.8 / 12.8sec ≒ 16K HZ ( u-Law )

85 sec 512K 256
K

If ex 23sec voice S.R. = 512K / 23sec ≒ 22K HZ ( ADPCM )

If ex 23sec voice S.R. = 256K / 23sec ≒ 11K HZ ( PCM )

If ex 23sec voice S.R. = 512K*0.8 / 23sec ≒ 17.8K HZ ( u-Law )

341 sec 2048K 1024K
If ex 64sec voice S.R. = 2048K / 64sec ≒ 32K HZ ( ADPCM )

If ex 64sec voice S.R. = 1024K / 64sec ≒ 16K HZ ( PCM )

If ex 64sec voice S.R. = 2048K*0.8 / 64sec ≒ 25.6K HZ ( u-Law )
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Voice Editing - Biên tập âm thanh thoại

There are many different kinds of sound editing software available. We recommend GOLDWAVE, COOLEDIT

AND SOUND FORGE. Có nhiều loại phần mềm biên tập âm thanh khác nhau. Chúng tôi đề xuất d ùng GOLDWAVE,

COOLEDIT AND SOUND FORGE

The following example is based on the GOLDWAVE, COOLEDIT AND SOUND FORGEsoftware. Use the

software to open a sound file, then followed by CUT, Paste and other commands to edit ing the sound. Resample

the sound using the sampling rate calculated from the table above. Depends on different voice and speaker, t ry to

find a suitable sampling rate to get best quality. When finished editing, use the SAVE AS command to convert the

sound into WAV, MONO 8 BIT format. Thí dụ sau đây dựa trên phần mềmGOLDWAVE, COOLEDIT AND SOUND

FORGE. Dùng phần mềm để mở một file âm thanh, sau đó thực hiện các lệnh CUT, Paste v à các lệnh khác để biên tập âm
thanh. Lấy mẫu lại (Resample) âm thanh d ùng tốc độ lấy mẫu được tính toán từ bảng ở trên. Tuỳ vào voice và loa khác

nhau, hãy cố tìm một tốc độ lấy mẫu phù hợp để có chất lượng tốt nhất. Khi kết thúc bi ên tập, hãy dùng lệnh SAVE AS để
chuyển đổi âm thanh thành định dạng file WAV, MONO 8BIT.

Normal, noise will be created when a sound file is sampling down into a smaller sampling rate. We usually use the

following technique to reduce the noise or distortion: Thường nhiễu sẽ được tạo ra khi một file âm thanh đ ược lấy mẫu
thành tốc độ lấy mẫu nhỏ hơn. Nên chúng tôi thường dùng kỹ thuật giảm nhiễu ồn như sau:

● EQ, Noise Reduction, Fade in, Fade out, Volu me, etc - Equalizer, Giảm nhiễu, Phóng to, Thu nhỏ, Âm l ượng
v.v…

The value setting for the above com mands are not fixed. User should choose the suitable value for his/her

particular sound file. Thiết lập giá trị cho các lệnh trên không cố định. Người dùng nên chọn giá trị phù hợp cho file âm
thanh cụ thể của mình/

EQ setting example: Thí dụ thiết lập Equalizer

60 HZ or

below

Depend on situation, sometimes noise will be in this frequency rang, therefore, we need to

decrease the gain of this frequency range - Tuỳ trường hợp, đôi khi nhiễu sẽ ở trong dải tần n ày,

do đó ta cần giảm khuếch đạnh của dải tần n ày.

150 HZ Dog bark, Drum - Tiếng chó sủa,…

400 HZ Male speech - Giọng đọc đàn ông

1000 HZ High pitch male, female speech -  Giọng nữ, nam cao

2400 HZ High pitch female - Giọng nữ cao

6000 HZ Children - Giọng trẻ con

15K HZ

or above

Usually, we will reduce the gain of this frequency range into minimum because our voice chip

can not response to this. – Thường chúng ta sẽ giảm khuếch đại của dải tần n ày xuống nhỏ nhất vì

chip voice của chúng ta không thể đáp ứng cho dải này.
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1. Let’s use GOLD WAVE as an example to demonstrate how to edit the sound sources. Open
the original sound file as below: Chúng ta sẽ dùng Gold Wave như một thí dụ để mô phỏng cách làm
thế nào biên tập các nguồn âm thanh. Hãy mở file âm thanh nguồn như sau
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2. Convert the sound file to the format that we can accept (WAV and MONO) Hãy chuyển đổi
file âm thanh sang định dạng chúng ta có thể chấp nhận (WAV và MONO)



Date: June 2010 – Copyright 2011 by www.tula.vn, Đông Anh – Hà Nội –  Việt Nam |   E-mail: info@tula.vn | Tel.: 04.39655633 5

EASY STEPS TO PROGRAM OTP VOICE CHIP APLUS
Các bước dễ dàng để nạp dữ liệu cho chip Voice kiểu OTP

3. Save as another file name after choosing the correct format. Lưu thành tên file khác sau khi
lựa chọn đúng định dạng

4. Click “OK” to confirm to accept the change of file format. Chọn OK để xác nhận, chập nhận
sự thay đổi định dạng file.
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5. The sample rate is dependent on which IC body is used. We have the following IC bodies:
Tốc độ lấy mẫu còn tuỳ thuộc vào con IC nào được dùng. Chúng tôi có các con IC sau đây:

OTP CHIP 10 SEC 21 SEC 42 SEC 85 SEC 170 SEC 341 SEC

Memory Size ADPCM encoding - Kích

thước bộ nhớ mã hoá kiểu ADPCM
64K 128K 256K 2512K 1024K 2048K

To determine the SAMPLE RATE, we use the following formula: Xác định tốc độ lấy mẫu theo công thức sau
SAMPLE RATE = Memory Size / number of SEC Tốc độ lấy mẫu = Kích thước bộ nhớ / Số GIÂY

e.g. If we are going to use the 10SEC IC, the memory si ze is 64K, therefore the sample rate is:

64K / 10 = 6.4KHz Thí dụ dùng IC 10 giây, bộ nhớ 64K thì tốc độ lấy mẫu là 64K/10 = 6.4KHz

The maximum sampling rate should be a little smaller than the above value. Therefore, 6.0KHz

rather than 6.4KHz should be used. Tốc độ lấy mẫu tối đa nên nhỏ hơn 1 chút so với giá trị trên, tức là
6.0KHz so với giá trị 6.4KHz nên được dùng.

After obtaining the sample rate, we should resample the original sound. If GOLDWAVE is used, and
assume the new sample rate is 12KHz, then, we can resample the sound file using ‘Effect’ and ‘Resample’
to modify the sample rate as shown in the figures bellows: Sau khi đạt được tốc độ lấy mẫu, chúng ta nên lấy mẫu
lại cho âm thanh gốc. Nếu dùng phần mềm GOLDWAVE th ì tính ra tốc độ lấy mẫu mới là 6KHz x 2 = 12KHz, thì ta có thể
lấy mẫu lại file âm thanh dùng “Effect (hiệu ứng)” và “Resample (Lấy mẫu lại)” để hiệu chỉnh tốc độ lấy mẫu nh ư chỉ ra
trong hình sau:
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6. Normally, we will have high frequency noise introduced when we resample the original sound file. This

high frequency noise can be reduced by using the Equalizer function as shown below: Thông thường, ta sẽ
có nhiễu tần số cao khi ta lấy mẫu lại file âm thanh gốc. Nhiễu tần cao n ày có thể được giảm bớt bằng cách dùng chức
năng Equalizer như sau đây
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7. Convert the sound file to the format that we can accept ( 8-bit ) Chuyển đổi file âm thanh
sang định dạng mà ta chấp nhận (8-bit)
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8. Click “OK” to confirm to accept the change of file format. Chọn OK để xác nhận thay đổi
định dạng file
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9. Remove the silence portion at the begin and end of the sound can reduce the chance of
“POP” sound to happen. Xoá bỏ phần âm trầm ở đầu của bắt đầu và kết thúc của âm thanh có thể
giảm ảnh hưởng của tiếng POP xảy ra.
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10. Finally, If there are very low volume part in the middle of the sound, it should be converted

to total silence otherwise, the low volume sound maybe become noise sound in the final IC.
Cuối cùng, nếu có phần âm lượng rất thấp ở giữa của âm thanh th ì nên chuyển đổi nó tất cả thành âm câm

(silence), nếu không thì âm thanh thấp này có thể trở thành âm nhiễu trong IC cuối cùng.
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Compile of Sound File Biên dịch file âm thanh

When the sound file is prepared, the aIVR20W software is used to compile and convert the sound file into .dat
format data file to be programmed into the voice chip.

Khi file âm thanh được chuẩn bị rồi (tức đã được biên tập xong như đã làm ở trên) thì phần mềm aIVR20W được dùng để
biên dịch và chuyển đổi file âm thanh thành định dạng file dữ liệu .dat để được nạp vào trong con chip voice của mình.

Procedures to Compile: Thủ tục biên dịch

1. Select the suitable IC chip to be used. Chọn con chip phù hợp cần dùng

2. Select the trigger mode to be used, CPU or KEY mode. Chọn chế độ trigger (kích hoạt) sẽ dùng, chế độ CPU hay KEY

3. Select the speaker output to be used, VOUT <PWM> or COUT <DAC>. Chọn đầu ra Loa cần sẽ dùng, VOUT
<PWM> hay COUT <DAC>

4. Add the edited WAV files. Thêm các file WAV đã biên tập
5. Select the encoding method to be used, ADPCM or PCM. Chọn phương pháp mã hoá sẽ dùng là ADPCM hoặc PCM

6. Select the number of voice groups.( Double click ) Chọn số các nhóm voice (kích kép chuột)
7. In each voice group, select the trigger mode, LEVEL or EDGE, HOLD or UNHOLD, Retrigger or Non-
retrigger.

Trong mỗi nhóm voice, chọn chế độ  trigger (kích hoạt) tương ứng là: LEVEL (mức) hoặc EDGE (cạnh), HOLD
(giữ) hoặc UNHOLD (không giữ), Retrigger (kích hoạt lại) hoặc Non-retrigger (không kích hoạt lại)
8. Double click the already added voice files into each voice group. Kích kép các file voice đã thêm rồi vào trong mỗi
nhóm (kích kép chuột lên mỗi tên file voice trên cửa sổ bên trái để thêm nó vào trong mỗi nhóm voice ở cửa sổ bên phải)
9. Then Click the, Done which can continue next group. Sau đó Click chuột nút Done để làm bước tiếp theo

10. Click the COMPILE button to c ompile and save the above selected options and voice file into .dat file.

Click chọn nut COMPNET để biên dịch và lưu các tuỳ chọn đã chọn ở trên và file voice thành file .dat

Function: Chức năng

Edge and Level Trigger: Kích hoạt Cạnh và Mức

For both Edge and Level trigger, the chip starts to play when the trigger button is pressed. For Level
Trigger, if the trigger key is pressed and keep holding at the pressed position, the chip will continue to play
the same sound again and again until the trigger key is released. However, if the chip is programmed to
Edge Trigger, the chip will play the sound only for one time even the trigger key is kept pressing.

Cả 2 kiểu này, chip sẽ bắt đầu play khi nút trigger (kích hoạt) đ ược nhấn. Với Level Trigger th ì phím trigger được nhấn
và giữ ở vị trí đã nhấn thì chip sẽ vẫn tiếp tục play lặp đi lặp lại c ùng đoạn âm thanh cho tới khi phím trigger đ ược nhả
ra. Còn kiểu Edge trigger thì chip chỉ play một lần thậm chí phí vẫn được nhấn.

Hold and Unhold Trigger: Kích hoạt Giữ và Không giữ

For Holdable Trigger, the chip will play only when he trigger key is kept pressing. Sound playback will stop

immediatly once the key press is released. For Un-holdable Trigger, the sound section will be played to

finished once the trigger is pressed no matter the trigger key is kept pressing or released.

Với Holdable trigger, chip sẽ play chỉ khi phím trigger đ ược nhấn giữ. Âm thanh sẽ ngừng ngay tức khắc khi nhả tay kô
giữ. Với Un-holable trigger, phần âm thanh sẽ được play và bị kết thúc khi phím trigger nhấn xuống. Khi phím trigger
được giữ hoặc nhả ra thì kô ảnh hưởng gì.
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Non-retrigger and Retrigger: Không kích hoạt lại và Kích hoạt lại

For retrigger option, the currently playing sound will be stoped and new sound section will be played when

another trigger key is pressed. For non-retrigger option, new trigger action will not be granted until the

current sound section is finished playing.

Với tuỳ chọn kích hoạt lại, âm thanh hiện thời đang k êu sẽ bị ngừng và phần âm thanh mới sẽ được kêu tới
khi phím kích hoạt khác được nhấn. Với tuỳ chọn không-kích hoạt lại, hành động kích hoạt mới sẽ không có
tác dụng tới khi đoạn âm thanh hiện thời k êu xong.

PWM or COUT: PWM hay COUT

PWM output is used to drive a small speaker ( < 1/2 W speaker) directly. That means user can connect a

small speaker to the VOUT1 and VOUT2 directly without adding extra circuit component. However, the

sound volume will be limited. On the other hand, COUT is a current mode analog output in which at least a

NPN transistor is needed as a amp lifier. More high power amplifier can also be used with this COUT output

to obtain larger power output.

Đầu ra PWM được dùng để làm kêu một loa nhỏ (loa nhỏ hơn 1/2W) trực tiếp. Có nghĩa là người dùng có
thể kết nối một cái loa nhỏ tới VOUT1 v à VOUT2 trực tiếp mà không thêm linh kiện mạch phụ trợ. Tuy
nhiên, âm lượng kêu sẽ bị giới hạn. Nói cách khác, COUT l à đầu ra analog (tương tự) chế độ hiện thời mà ở
đó ít nhất một transistor NPN đường cần dùng như một bộ khuếch đại. Bộ khuếch đại công suất cao h ơn có
thể được dùng với đầu ra COUT để đạt được đầu ra công suất lớn hơn.

OTP Chip Programming Nạp trình (ghi) chip OTP (One Time Programming – chỉ ghi 1 lần)

Go the Writer page, press the Load File button to load the .dat file into the software. Note the CHECK SUM

value. It should be the same as the value after Compile. If it is different, that means the .dat file is corrupted.

Voice files must be compiled a gain. Insert the suitable chip into the PC programmer socket and press the

Program button to start the programming. Upon finished, a Program Passed should be display. That means the

voice chip is programmed successfully.

Vào trang Ghi (Writer), nhấn nút Load File để tải file .dat vào trong phần mềm. Chú ý giá trị CHECK SUM.
Nó nên giống như giá trị sau khi Biên dịch (Compile). Nếu nó khác, có nghĩa l à file .dat bị lỗi. Các file âm
thanh (voice) phải được biên dịch lại. Cắm chip phù hợp vào khe đế bộ nạp và nhấn nút Program để bắt
đầu nạp (ghi). Khi kết thúc, một  chỉ thị Program Passed nên được hiển thị. Có nghĩa là chip voice được
nạp thành công.

Tài liệu này được soạn dịch bởi TULA Solution

“MỌI NHU CẦU LIÊN QUAN CHIP GHI ÂM THANH (VOICE IC)

VUI LÒNG LIÊN HỆ CÔNG TY TNHH GIẢI PHÁP TULA”
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HƯỚNG DẪN CHUYỂN ĐỔI VÀ BIÊN TẬP THÀNH FILE

NHẠC WAVE NẠP CHO CHIP PHÁT NHẠC CỦA APLUS & NUVOTON

Chạy phần mềm Goldwave, mở file alarm-clock-1.mp3

Sau đó File -> Save As thành file wav chuẩn PCM 8-bit mono:

Tiếp đó lấy mẫu tần số 20KHz (ứng với 20000) hoặc tần số nào mong muốn, Effect -> Resample:
(Nếu dung lượng file lớn quá hoặc cần giảm bớt dung l ượng thì lấy mẫu tần số thấp hơn và ngược lại)

Tiếp đó tăng 100% âm lượng, Effect -> Volume -> Maximize Volume -> [Full dynamic range]:

Muốn tăng âm lượng to lên 150% của hiện thời, Effect -> Volume -> Change Volume -> [150%]:

Muốn chỉnh hiệu ứng nhạc cho mượt hơn hoặc loại bỏ nhiễu, tạo các hiệu ứng âm thanh th ì vào
Effect -> Filter -> chọn chức năng & thông số tương ứng rồi nghe thử theo ý.
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